G STaTe oF New JErsey
Ao

ScHOOLS DEVELOPMENT AUTHORITY

Section 16

Project Cost Report Module

ORACLE Primavera

Contract Management User Manual Page 1 of 14 Created: 6/1/07
Section 16 — Project Cost Report Module Revised: 11/21/12



Table of Contents

Section Title Eligﬁber

I. The Project Cost Report Module 3
Il. Viewing Data in the Project Cost Report 5

A. Project Cost Report Layouts 5

B. The Split Bar 6

C. Exporting the Project Cost Report to Excel 6

D. Auvailable Columns in the Project Cost Report Log View 8
I11. Printing Data in the Project Cost Report 9

A. Budgeted, Committed and Actuals Report 12

B. Advanced Reports 14

Contract Management User Manual Page 2 of 14
Section 16 — Project Cost Report Module

Created: 6/1/07
Revised: 11/21/12



THE PROJECT COST REPORT MODULE

The Project Cost Report module provides a central location for analyzing budgeted, committed and
actual project costs. It is located within the Contract Information module.

The cost codes associated with this report are loaded in at the time the project is created in

Contract Management. As costs are incurred against a project, the applicable cost codes are
updated. The various columns in the report allow the user to track project costs as they are entered

and approved in the system.

For descriptions of all available cost codes, refer to Section 34 (Appendix B) of the User Manual.

1. Once logged into Primavera, the Contract Management Control Screen displays (as shown).

ORACLE' Primavera Contract Management Change Group  Print  Help  Logout
Welcome, Jennifer Irizarry May 29, 2012
‘Contract Management Control Center
Al Prejects =) Workspace:  (My Workspace) - N
o=
|_f‘ Actions 2% & Alerts I S @E
! Hgh 0 ! High 268
* Normal o * Normal o
4 Low o 4 Low o
Last System Refresh: May 29, 2012 1:00:25 AM EDT
Prepare Reports i Prepare Reports e
B 01 - Project status Report - External Use (r ... B o1 - Multi-Project Pending Pavment
[ 01 - Sinale Project Status Report - Internal ... [ 02 - Multi-Proiect Dailv Reports - Past 7 Dav...
Y 02 - Issues Log by Praject (r is Olsda all) [ 24 - School Type Report - Regional (m_proj_sc...
[ 26 - Multi-Project €CD Report - Executed in t...
[l 010810 - Phillipsburg Esrly Childhocd Centar
& o108 - )
2 010818 - New >
Ll ] »
Primavera Contract Management /' Trusted sites | Protected Mode: OFf 45 v ®100% -
— T —r ————r
Contract Management Control Center
@llifoiects _ T Workspace:  (My Workspace) - Q\\@ =
& [% = [
> - [ hip S Actions Z28Gg Alerts N @
! High o ! Hich 268
Change Order Management ° Normal 0 * Normal 0
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3. Open the Contract Information folder (a list of modules will display) and click the Project
Cost Report module.

- 04000V - Arthur L Jehnson HS (Clark Township) s
D Froject Information
D Communication
—— "Ela Contract Information

: @ Froje 5
[ contracts - Budgeted
[# contracts - Committed
@ Purchase Orders

@ Trends

@ Payment Requisitions

4. The Project Cost Report log view displays.

Control Center >

; P& Leyour [amyiyow ]
Pr0|ect Cost nepol‘l {Displayed in U.S. dollar} ® Leyout | €my layout ¥ &e
123455678310 [Neat >>][Last] Find
Code Title Criginal Budget Approved Budget Fevisions
Print Report (S| g » 010 Real Estate Services $0.00 $0.00
Print Preview [ &), @g ® 01010 Predevelopment $669.003.00 $0.00
@9 » 01010.00 Site Survey $0.00 $0.00
g » 010.10.080 Predevelopment Relocation $0.00 $0.00
co @g » 01010.080 Pradevelop Agremnt notto lease $0.00 $0.00
g & 010.10.091 Predevelopment Reimbursements $0.00 $0.00
@" o 010.20 Froperty/Land Furchase $1.381.801.00 $0.00
» return lo control center &, 10,20,01 PFislocation Consultant $0.00 §0.00
g » 010.20.01.081 Relo Consult Program Costs $0.00 $0.00
@g » 010.20.01.082 Relo Consult Labor Costs $0.00 $0.00
@9 o 010.20.01.083 Fielo Cansult Other Direct Costs $0.00 $0.00
g » 010.20.01.084 Relo Consult Moving Estimates $0.00 $0.00
@g & 010.20.01.085 Relo Consult Property Manage Sves $0.00 $0.00
g & 010.20.01.088 Relo Cansult Delivery Cost $0.00 $0.00
@" o 0102002 Title Search Fees $0.00 $0.00
g o 010.20.100 Land Acg. Negotistor Labar $0.00 $0.00
g o 010.20.110 Land Acq. Negaotiator Other Direct $0.00 $0.00
@g % 010.20.200 Land Acg. (Purchase) $0.00 $0.00
@9 o 010.20.210 Land Acg. [Condemnation)) $0.00 $0.00
g s 010.20.215 Land Acg. Legal $0.00 $0.00
@g s 01020220 Rieal Estate Taxes $0.00 $0.00
g o 010.20.225 Deed Natice $0.00 $0.00
@" o 01030 Enviranmental $0.00 $0.00
g » 010.30.10 Ernvironmental Consultant $0.00 $0.00
g o 010.30.20 Femediation Services $0.00 $0.00
Log Totals: $35.660.566.00 $0.00

i~
v

0000000000000 ]
-
Contract Management User Manual Page 4 of 14 Created: 6/1/07
Section 16 — Project Cost Report Module Revised: 11/21/12



1. Viewing Data in the Project Cost Report

A. Project Cost Report Layouts

Layouts are used to define a filter, sort, and group items in a log view. For example, if a user
desires to utilize a certain combination of columns repeatedly, a layout can be modified and
applied to the relevant log window.

Layouts are applied by selecting the Layout dropdown box at the upper right corner of the log

VIEW.
Control Center > Project Cost Report
Project Cost Report  Select an action... - W 112345 .. 03 H Find i Layout: <my layout>
F| ‘ Cost Code Title Original Budget Approved Budget
i g ® 010 Real Estate Services $0.00 $0.00
|§| @ © 010.10 Predevelopment £0.00 £0.00
|E| g ® 010.10.01 Site Survey $0.00 $0.00
)
- g ¢ 010.10.080 Predevalopment Relocation $0.00 £0.00 2
g » 010.10.090 Predevelop Agremnt not to lease £0.00 £0.00
|§f % 010.10.091 Predevelopment Reimbursements $0.00 $0.00
g © 010.20 Property/Land Purchase $0.00 £0.00
g % 010.20.01 Relocation Consultant £0.00 £0.00
Iﬁ ® 010.20.01.081 Relo Consult Pragram Costs $0.00 $0.00

There are a number of custom layouts that have been predefined for the Project Cost Report.

I

Control Center > Project Cost Repart

Proiect Cost Report  Select an action... - 12345 .. 3@ Find Wx Layout: <my layout>
Title Budget Adjustments ‘ Projected Budget Original Commitment Al Codes it~
Below the Line I
d

= B oow Real Estate Services s0.00 s0.00 50.00 Construction o
Cost Codes w/ values
|% B o 0w Bresiealonrmar ¢ s0.00 s0.00 s0.00 Designfess. . 63
I@ % > a10.10.01 site Survey s0.00 50.00 S ¢
All Codes Displays all cost codes created for this project and all available columns

Below the Line | Filters to show only Below the Line budget and commitment amounts (the B
at the end of each of these codes is the indicator that this is a below the line
cost). All Below the Line costs are coded for reporting purposes

Construction Filters to show Construction cost codes that start with 030

Cost Codes Filters to show only line items with budget values

wi/values

Design Fees Filters to show all Design Fee cost codes that start with 020

Real Estate Filters to show all Real Estate Services cost codes that start with 010
Services
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B. The Split Bar

A split bar is provided in the Project Cost Report module to allow users to divide the screen
into two scrollable sections. This allows one side of the screen to remain constant, while the
other can be moved to display more information.

Just place the cursor over the red vertical bar on the right side of the window and click and
drag it to display the columns you want, or move it all the way to the left to disable it. Double-
click the red bar to return it to its original position

QOriginal Budget Approved—=
$6,738,000.00 %)
$0.00
$0.00

C. Exporting The Project Cost Report to Excel

The log view will display the overall summary details of the Project Cost Report; however, this
log view can be exported to Excel for reporting purposes. Once exported, you can manipulate
the information to create a customized report.

IMPORTANT: Information can only be exported from Contract Management. You cannot
import or upload information into the system.

1. To export the Project Cost Report, choose the Excel icon located on the upper right
hand corner of the screen.
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Control Center > Project Cost Report
. H y Fr
Project Cost Report  Select an action... - W (f12345,.. 3@ Find = Jayout: =my layout= -
() | Cost Code Title Budget Adjustments Projected Budget Original Commitment App *
&) {
|§f 2 010 Real Estate Services $0.00 $0.00 $0.00
@ 5 010.10 Predevelopment $0.00 50.00 $0.00
g ® 010.10.01 Site Survey £0.00 £0.00 $0.00
1
@ # 010.10.080 Predevelopmeant Relc $0.00 £0.00 $0.00 3
&



2. If you receive the following error message after you click the Excel icon, perform the
steps listed below:

Windows Internet Explorer

! M5 Excel must be installed on the system. Also, configure the browser to run ActiveX controls: open the browser, select Tools, Internet Cptions,
Security, Custom Level, and dick the Enable button under Run ActiveX controls and plug-ins.

E Automation server can't create object
L

Add http://pe.njsda.gov to Trusted Sites Zone (bookmarks).
a) Go to Tools -> Internet Options -> Security -> Trusted Sites (Green Circle)
b) Click Sites Button
¢) Uncheck require https: on the bottom of the Trusted Sites page
d) Add http://pe.njsda.gov
e) Close and re-open your browser.

3. If Microsoft Excel still does not open, contact the PE Helpdesk
(pehelpdesk@njsda.gov) to assist in troubleshooting your Internet browser settings.

4. If no error message displays, Microsoft Excel will automatically open and display the
Project Cost Report. You can now manipulate this output as desired to create your
customized report.

A= R RN - S Currentlayout [Read-Only] - Microsoft Excel o (0 el
m Home | Inset  Pagelayout  Formulas  Data  Review  View  Developer 2@ o@ R
B & o Arial T WA S wrap Text General - B 7 () o Tk L] T Atesum~ 3
B2 copy ~ ATE J . }é Hpd 50 @ j ‘:—1 rn- %? ﬁ
P Fromatroner B L U2 B A = bl SRR e S e B s P 8 oS A W i et
Clipboard . Font 2 Alignment , Humber g Styles Cells Editing
A2 w £ | 010 v
[ A I B c D E F =
1 Cost Code Title Original Budget ($) $) Revised Budget ($)
2 [010 14> 3l Estate Senvices 0.00 0.00 0.00 =
3 010.10 Predevelopment 0.00 0.00 0.00
4 010.10.01 Site Survey 0.00 0.00 0.00 |
5 010.10.080 Predevelopment Relocation 0.00 0.00 0.00
6 010.10.090 Predevelop Agremnt not to lease 0.00 0.00 0.00
7 010.10.091 Predevelopment Reimbursements 0.00 0.00 0.00
g 010.20 Property/Land Purchase 0.00 0.00 0.00
9 010.20.01 Relocation Consultant 0.00 0.00 0.00
10 010.20.01.081 Relo Consult Program Costs 0.00 0.00 0.00
11.010.20.01.082 Relo Consult Labor Costs 0.00 0.00 0.00
12 010.20.01.083 Relo Consult Other Direct Costs 0.00 0.00 0.00
13 010.20.01.084 Relo Consult Moving Estimates 0.00 0.00 0.00
14 010.20.01.085 Relo Consult Property Manage Svcs 0.00 0.00 0.00
15 010.20.01.086 Relo Consult Delivery Cost 0.00 0.00 0.00
16 010.20.02 Title Search Fees 0.00 0.00 0.00
17 010.20.100 Land Acg. Megatiator Labor 0.00 0.00 0.00
18 010.20.110 Land Acq. Megatiator Other Direct 0.00 0.00 0.00
19 010.20.200 Land Acq. (Purchase) 0.00 0.00 0.00
20 010.20.210 Land Acg. (Condemnation)) 0.00 0.00 0.00
21 010.20. 215 Land Acq. Legal 0.00 0.00 0.00
22 010.20 220 Real Estate Taxes 0.00 0.00 0.00
23 010.20 225 Deed Notice 0.00 0.00 0.00
2401030 Environmental 0.00 0.00 0.00
25 010.30.10 Environmental Consultant 0.00 0.00 0.00
26 010.30 20 Remediation Services 0.00 0.00 0.00
27 010,40 Relocation 0.00 0.00 0.00
28 010.40.075 Owner Housing Supplement 0.00 0.00 0.00
29 010.40.076 Tennant Rent Supplement 0.00 0.00 0.00
30 010.40.077 Repacement Housing Closing Costs 0.00 0.00 0.00 -
W 4 b M| Sheetl Sheet? Sheetd , €2 gl I ] _ »
Ready | B3] | |[ED@m 100% (=) [} +)
—— —— et ——
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D. Available Columns in the Project Cost Report Log View

Column Heading

Definition

Cost Code A break down of cost elements for a project
Title A description of the cost code
Budget Data

Original Budget

Costs that have been distributed from a contract or trend

Approved Budget Revisions

Costs that have been distributed from an approved budget
trend

Revised Budget

The sum of the Original Budget and the Approved Budget
Revisions

Pending Budget Revisions

Not using

Estimated Budget Revisions

Not using

Budget Adjustments

Costs distributed from a budget adjustment trend

Projected Budget

The sum of the Original Budget, the Approved Budget
Revisions, the Pending and Estimated Budget Revisions,
and the Budget Adjustments

Commitment Data

Original Commitment

Costs distributed from a contract

Approved Commitment

Costs distributed from an approved change order

Revised Commitment

The sum of the Original Commitment and the Approved
Commitment

Pending Commitment

Costs distributed from an Authority Agent
Recommendation (AAR) or an unapproved change order

Estimated Commitment Revisions

Cost estimates distributed from a Contract Change
Request/Authority (CCR/A)

Commitment Adjustments

Not using

Projected Commitment

The sum of the Original Commitment, the Approved
Commitment, the Pending and Estimated Commitments,
and the Commitment Adjustments

Actuals Data

Actuals Received

Costs distributed from an invoice (if the contract/payment
requisition is distributed to Committed)

Actuals Issued

Costs distributed from an invoice (if the contract/payment
requisition is distributed to Budgeted)
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Column Heading

Definition

Variance Data

Original Variance

The Original Budget minus the Original Commitment

Approved Variance

The Revised Budget minus the Revised Commitment

Pending Variance

(Revised Budget + Pending Budget Revisions) - (Revised
Commitment + Pending Commitment)

Project Variance

The Projected Budget minus the Projected Commitment

Percent of Total Data

Budget Percent

This amount represents the percentage of the total amount
budgeted for the line item

Commitment Percent

This amount represents the percentage of the total amount
committed for the line item
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I11. Printing Data in the Project Cost Report

There are a variety of reports available from this module.

1. Once logged into Primavera, the Contract Management Control Screen displays (as
shown).

ORACLE Primavera Contract Management Change Group  Print  Help  Logout

Welcome, Jennifer Irizarry May 29, 2012

Contract Management Control Center

ik Bojects, =) Workspace:  (My Workspace) - N
o =
BE|% A
= Actions 2§ e Alerts & &
[l 000714 - Number 7, Grant E.S. (Passaic City) |=‘
[E] 000467 - Hubberd M.5. (Flainfield) =
=] 000204 - Paterstown E.S5. #2 (Elizabath) 0 . 5
[E] 000810 - John Marshall E.S. #20 (Elizabeth) ! High 0 ! High 268
[ 000811 - Elizabeth H.5. (Elizabath] 5 o R o
[E 000702 - John F. Kennedy H.S. (Patersan)
[E) 010085 - New pre K-8 #27 (Elizabeth) 4+ Low o 4 Low o

[E] 010090 - New pre K-8 #28 (Elizabsth)
[E] 010081 - Dr. Albert Einstein #29 (Elizabeth) Last System Refresh: May 29, 2012 1:00:25 AMEDT
[E] 010522 - New MS [201) (Lang Branch)

[E] 010554 - Memarial H.5. (West Naw Vark)
[E] 010556 - Number 3 E-5. (West New Yord]

[E] 010557 - Numzer & E.5. (West New York) Prepare Reports i Prepare Reports B
[E] 010553 - Number 2 E.5. (West New York)
] 010552 - Unien City ECC {Schlemm) B 01 - Project status Report - External Use (r ... B o1 - Multi-Project Pending Pavment

010571 - [DP] Un City HS &
a [DFy Unien city " B 01 - Single Project Status Report - Internal .. B 02 - Mutti-Project Dailv Reports - Past 7 Dav...
[E] 010580 - Number 24 £.8. [Jersey City)

- lersey Cif - Issues Log roje: ris sda_al - School pe Report - Regional (m proj sc...

B2 010581 - PS #20 (arsey City) 02 -1 Log by Project (r is Oisda all) 24 - School Type Report - R ¢

[E] 010587 - ECC 03 (Jersey City)

&l 010583 - ECC 12 Wersey City)

[E] 010854 - ECC 14 (Jersey City)

[E] 010587 - ES 3 (Jersey City)

[E] 010810 - Phillipsburg Esrly Chilshosd Center
[E] 010617 - New Science Park HS (Newark)

[ 26 - Multi-Project CCD Report - Executed in t...

@ 010818 - New First Avenue (Newark) -
<1 i |+
Primavera Contract Management ' Trusted sites | Protected Mode: Off 43 v ®100% ~
— ™ ——————r

2. Select your desired project.

‘Contract Management Control Center

Al Projects x| | Workspace: ﬁMy Workspace) - an E ‘
B | % =
_j» - Asthur L Johnson HS (Clark Township RS Actions 2N g Alerts LU
(-2 Project Information

(- (Z] Communicatien

[-[Z) Contract Informaticn ] . ] i

(1] 268
i 4 High Ly High
[#-[Z] Change Order Management +  Normal 0 ¢  Normal o

0000000000000 ]
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3. Open the Contract Information folder (a list of modules will display) and click the

Project Cost Report module.

- 04000V - Arthur L Jehnson HS (Clark Township)
; D Froject Information

D Communication

a Contract Information

>

5| Fro
‘[ contracts - Budgeted
[# contracts - Committed
@ FPurchase Crders

@ Trends

@ Payment Requisitions

----- @ Procurement/Bids

4. The Project Cost Report log view displays.

Control Center > Project Cost Report

Project Cost Report  Select an action... - W123a5..038H Find Bs: Layout: <my layout=
6‘ | Cost Code Title | Original Budget R rorve R Rt Revised Bud +
—_— g 2 010 Resl Estate Services s0.00 $0.00 50|
‘@‘ g ® 010.10 Predevelopment £0.00 £0.00 £0
@‘ g % 010.10.01 Site Survey s0.00 £0.00 50|
o g ¢ 010.10.080 Sradevelopment Relocation £0.00 £0.00 0~
g ® 010.10.030 Predevelop Agremnt not to leasze $0.00 $0.00 50|
g % 010.10.091 Predevelopment Reimbursements £0.00 £0.00 50|
@g © 010.20 Property/Land Purchase £0.00 50.00 50| |
g 9 010.20.01 Relocation Consultant £0.00 £0.00 £0
g % 010.20.01.081 Relo Consult Program Caosts £0.00 $0.00 $0
g ® 010.20.01.082 Relo Consult Labor Casts £0.00 £0.00 $0
g 2 010.20.01.083 Rela Consult Other Direct Costs s0.00 £0.00 50
g & 010.20.01.084 Relo Consult Moving Estimates £0.00 £0.00 50
g ® 010.20.01.085 Rela Consult Property Manage Sves £0.00 $0.00 %0
| Log Totals: £0.00 | $0.00 $0.0
4| [ | 3
Primavera Contract Management E /" Trusted sites | Protected Mode: Off a v WMI100% -

Contract Management User Manual
Section 16 — Project Cost Report Module

Page 11 of 14

Created: 6/1/07
Revised: 11/21/12



A. Budgeted, Committed and Actuals Report

1. To print the Project Cost Report, click the Print Report button on the left side of the

screen.
Control Center > Project Cost Report
Project Cost Report  Select an action... - W 4]12345 .. [ M Find
| Cost Code Title |

Ig © 010 Real Estate Services
Iﬁ © 010.10 Predewvelopment
g @ 0i0.10.01 Site Survey
g ® 010.10.080 Predevelopment Relocation
=7 C e ammn -

2. The Print dialog box will display. Choose your desired printer number or Adobe PDF
from the Name drop down box. Choose any other desired options and click the OK
button when finished. You will return to the Project Cost Report log view.

Frinter

— | aTIE
Status:  Ready
Type:  HP Lazerlet 3150 PS

Frint Range

@ Al

() Current view

() Current page

() Pages frorn:|‘| | o |11 |

Page Handling

-

Copies: _

Subzet:| All pages in range w |[] Reverse pages

Fage Scaling: | Reduce to Frinter Marging

Auto-Rotate and Center

[] Choose Paper Source by PDF page size

[ Print ta file
[ Print color a2 black

’F'linting Tips] [ Advanced

Comments and Forms:

| Document v
Freview
|5 |
k n A

85

.

Units: Inches Zoom: 98%
111 [1)

[ OF. l[ Cancel ]
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3.
on the left side of the screen.

If you would prefer to see the report before it is printed, click the Print Preview button

Control Center > Project Cost Report

Project Cost Report  Select an action... - W 4]12345 .. [ M Find
@ | Cost Code Title |
\_‘) Ig & 010 Feal Estate Services
’g‘ Iﬁ © 010.10 Predewvelopment
@‘ g % 010.10.01 Site Survey
]

g ® 010.10.080 Predevelopment Relocation
=7 C e ammn -

4. The report output will display as shown. If you are satisfied with the output, click the

Print button on the top of the screen. You can choose

to receive a printed output or

choose to save the file as an Adobe PDF file. When completed, click the Close button.

f — N S — EI B
@ https://dev2pe.njsda.gov/?url=decumentation.do%3Faction%3Dshow26doctype¥ 3DreportSe26sysitemtype - Windows Internet Explorer l — &J
. .

(=

1 /1 ikl s & | ® @ [w0% - | - Sign *
A 4 o

= K |Find -

=

New Jersey Schools Development Auth

Job No:
Project No: 0850-005-04-000V

Budgeted, Committed, Actual Costs

Budget Committed Actuals

Cost Code Original Amount Revised Frojected Original Amount Revised Projected Received Is=

010 50.00 $0.00 50.00 50.00 $0.00 50.00 50.00

Real Estate Semvices

010.10 50.00 $0.00 50.00 50.00 $0.00 50.00 50.00

Predevelopment

010.10.01 50.00 $0.00 50.00 50.00 $B0 45875 59045375 $0B,7B7.55

Site Sunvey

010.10.080 50.00 $0.00 50.00 50.00 30.00 50.00 50.00

Predevelopment Relocation

010.10.080 50.00 $0.00 50.00 50.00 $0.00 $0.00 50,00

Predevelop Agremnt not to lease

010.10.081 50.00 $0.00 50.00 50.00 $0.00 $0.00 50,00

Predevelopment Reimbursements.

01020 50.00 $0.00 50.00 50.00 F0.00 $0.00 50.00

PropertylLand Purchase

010:20.01 $0.00 $0.00 §0.00 §0.00 $0.00 §0.00 50,00 -
11.00 x 850 in 4 b
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OO
. _____________________________________________________________________________________________________________________________|

B. Advanced Reports

There are a variety of additional reports available.

1. From the Project Cost Report log view, choose Advanced Print from the drop down box.
You can also click the Print link at the top right side of the page.

ORACLE Primavera Contract Management Tl Qufe vt sferen wels oot
Arthur L Johnson HS (Clark Township) (04000V) July 2, 2012
Control Center > Project Cost R
Project Cost Repofft | Select an action... - W (J12345.. 3 Find F:;' Layout: <my layout= -
Select an action...
O | Cost Code ‘prmt Report le Budget Adjustments Projected Budget Original Commitment App ~
Print Preview [
@" ® 010 =zl fstats Services $0.00 50.00 50.00
@ ® 010.10 edfvelopment £0.00 £0.00 £0.00
@ @ pio.10.08 = Jurvey $0.00 50.00 50.00
View Worksheet Versions E
|§f # 010.10.080 .- lopment Relc $0.00 $0.00 $0.00
rg"f # 010.10.020 lop Agremnt $0.00 50.00 50.00
@ httpsi//dev2penjsdagov/ - Pri ontract M - Windows Intemet Explarer B Ro ™™
Print - Project Cost Report help
Project Cost Report
01 - Single Project Status Report - Internal Use (r_proj_stat01_v4) -
02 - Project Charter Budget Status Report (r_pcr_charter_budget) F
03 - Actual and Variance Costs (r_cw_04) 3
@ Reports 04 - Budget vs. Actual Variance (r_cw_06) b
A 05 - Esud?et&d Costs (r_cw 02 [
) Dunning Letters 06 - Budgeted, Committed and Actual Costs - LANDSCAPE {r cw 01
07 - Committed Costs (r_cw_03) 1
PO e Qe et S ) S <

i i

Default Report: r_cw_01

i e |yt i s

Please select a report

3. Choose the desired report from the report window, then click one of the following
buttons.

Click Print to get a printed output.

Click Preview to see your output displayed in the window.

Click E-Mail to electronically send the output to another user.

Click Save As to save the output to your local computer or other desired location.
Click Close when finished to return to the Project Cost Report log view.
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